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Introduction

p.

he
Philips ThumbCam for laptops
The Philips ThumbCam for laptops you have just purchased is manufactured to the highest
standards and will give you years of trouble-free use.This new digital camera is the most
advanced means of recording quality movies or still photos quickly and easily on your lapto
After installation the camera can be used as a:
• laptop camera for video chat and video mail;
• digital camera for taking high quality photos;
• video camera for capturing video clips;
• 128 MB removable memory drive.

Please read the following instructions carefully.They provide a step-by-step description of t
installation process and explain how to use the Philips ThumbCam.
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• Please read the following instructions carefully, and retain them for future reference
• It may be helpful to have the instructions for use for the laptop at hand for referen

Safety precautions
Observe the following guidelines to ensure that the camera will operate safely and to prev
defects.

• Do not use your camera in environments outside the following range: temperature
to 40°C, relative humidity: 45% ~ 85%.

• Do not use or store your camera in/under:
– direct sunlight exposure;
– very humid and dusty environment;
– near any kind of heat sources;

• If your camera gets wet, dry it with soft cloth as soon as possible.
• Salt seawater may cause severe camera damage.
• If the lens or viewfinder is dirty, please use the lens brush or soft cloth to clean the

Do NOT touch the lens with your fingers.
• Clean the outside of the camera with a soft cloth.
• Do NOT use cleaning fluids based on alcohol, methylated spirit, ammonia, etc.
• Do NOT attempt to disassemble or repair your camera by yourself. Do not open t

camera. In the event of technical difficulties return it to your Philips retailer.
• Do NOT use your camera outdoors when it is raining or snowing.
• Do NOT use your camera in the water.
• Protect the camera from oil, vapour, steam, moisture, and dust.
• Never point the camera lens at the sun.

Copyright
Copyright© 2003 by Philips Consumer Electronics B.V. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval system or tra
into any language or computer language, in any form or by any means, electronic, mechani
magnetic, optical, chemical, manual or otherwise, without prior written permission from Ph
Brands and product names are trademarks or registered trademarks of their respective
companies.
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Please check that the following items are packed in the Philips ThumbCam box.
They are provided to help you set up and use your Philips ThumbCam.

The Philips ThumbCam Laptop clip with CD-ROM containing
for laptops USB cable attached the Philips installation 

software, application
software and manual

Neckstrap Quick Installation Guide

ThumbCam Thumb
Cam

ThumbCam
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2. Quick start
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Installation
1 Unplug all your USB devices (except USB keyboard and USB mouse).
2 Place the installation CD-ROM in your computer’s CD-ROM-/DVD drive.

3 Select your language.

4 Select at least ‘ThumbCam drivers’ and ‘Philips Photo Manager’.

5 Click ‘Start to install’ to start installation.

Note! If the the ‘Language Selection’ screen does not appear automatically, open Windows Exp
and double-click the ‘Autorun.exe’ icon in the CD-ROM directory.



Charging
1 Turn on the laptop.

laptop.
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2 Be sure to run the installation CD-ROM first, before connecting the camera to the 
3 Slide the lens cover downwards.

4 Connect the camera USB connector directly to the USB port of the laptop.

> appears on the display.The battery will now be charged.

Taking photos
1 Slide the lens cover downwards.

2 Press the Mode button to turn on the camera.

3 Frame the subject though the viewfinder.

US8



4 Press the Shutter button.

nager’
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> The Timer LED blinks once (red).
> You will hear a beep when the photo is taken.

Transferring photos/video clips to your laptop
1 Make sure the PC is turned on and that ‘ThumbCam drivers’ and ‘Philips Photo Ma

are installed.
2 Connect the camera USB connector directly to the USB port of the laptop.

> The camera turns on automatically and the display shows .
> The following screen will appear.

4 If you wish to start transferring press ‘YES’.
>The following screen will appear.

5 Select the photos you wish to transfer and press ‘OK’.

US8



> If the transfer is complete the following screen will appear.

lick on
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Notes!
– If the ‘Philips ThumbCam’ screen does not appear, you can start Philips Photo Manager and c

the 'Get Photo' icon. Select you camera (‘Philips ThumbCam’) to start the transfer.
– For more information on transferring/viewing photos and video clips see chapter ‘Transferring

photos/video clips to your laptop’ under ‘5. Operating the camera’.



3. Functional overview
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1 Viewfinder
for framing you photo subject

2 Timer LED
– blinks red for 10 seconds when the self-timer has been set
– blinks red once when a photo is taken

3 Lens
4 Strap hole
5 Lens cover
6 USB connector

for connecting the camera to the USB connector in the laptop clamp or 
directly to the USB port of the laptop

7 USB cover
8 Charge LED

blinks blue when the battery is being recharged
9 Mode button

– for turning the camera on and off
– for changing camera settings

10 Shutter button
for taking photos and making video recordings

0

4

7

6

9

1

8
!

1

2

3

4

5

7

6



11 Display
– lights up blue when the camera is turned on

ENGLISH12
– informs you about the present status of the camera:

12 USB cover
13 Laptop clip

for connecting the camera to a laptop computer
14 USB cable

for connecting the laptop clip to the USB port of the laptop

@

#

$

25 number of photos currently taken
St self-timer mode
Aul AVI mode (video recording)
CL clear last picture mode
CA clear all pictures mode

50H/60H Setting frequency (50/60 Hz)
 H/ lLo Setting resolution (high/low)
 H   lL      Setting  picture quality (high/low)
PC PC camera mode (webcam)
US8 USB mode (removable memory drive) 
OFF Power off

q q 
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Installing the camera software
The software supplied only works on laptops with the operating systems Microsoft® Wind
98SE, ME, 2000 and XP.

Notes!
– Unplug all your USB devices (except USB keyboard and USB mouse) before you start.
– Do not plug in your USB camera yet. First run the Installation CD-ROM-/DVD drive.
– Have your Windows® CD-ROM at hand.

1 Insert the installation CD-ROM supplied into the laptop’s CD-ROM-/DVD drive.
> The Language Selection screen will appear automatically.

2 Select your language.

Note! If the the ‘Language Selection’ screen does not appear automatically, open Windows Exp
and double-click the ‘Autorun.exe’ icon in the CD-ROM directory.

> The software installation screen will now appear.
3 Select at least ‘ThumbCam drivers’ and ‘Philips Photo Manager’.

There are three clusters of application software to install:
- software for video chat (Video Chat):
- software for image applications (Image);
- software for video applications (Video).
> If you move your cursor onto a button or application name, you will see a brief

introduction at the bottom of the menu.
• You can add the additional software by selecting the box in front of the software nam

Windows® NetMeeting, Philips Photo Manager, Philips VRecord, Acrobat Reader.



4 Click ‘Start to install’ to start installation.
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Note! If your Operating System is Windows® XP, continue the installation process when the dia
box below appears on the screen. (In Windows® 2000/NT, the same dialog box may als
appear.You may then continue the installation process.)

5 Follow the instructions on the screen to complete the installation.
6 Restart your computer when you have finished installing all of the above software.

> The V(ideo)-Lounge desktop shortcut will be installed after installation.
> Via VLounge you have access to all camera-related software.

Also see ‘Using the applications’.
7 Double click on the icon to initiate the VLounge application.

> The VLounge application will now be initiated and the VLounge selection screen app



Connecting the camera to your laptop
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Connection via the laptop clip
1 Place the camera into the USB cover of the laptop clip. Be sure to insert the camer

connector into the recess in the cover. Push it down gently until it clicks into posit
2 Press the clip open and attach it to the laptop lid (screen).

3 Connect the USB cable to the USB port of the laptop.
> The camera turns on automatically and the display shows .

Direct connection
• The camera can be connected directly to the laptop by inserting the camera USB

connector into the USB port of the laptop.

> The camera turns on automatically and the display shows .

Connecting the neck strap
• Click both ends of the neckstrap into the recesses on both sides of the camera.

US8

US8



Recharging the battery 
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1 Make sure the camera is turned off.
2 Turn on the laptop.
3 Slide the lens cover downwards.

4 Connect the camera USB connector directly to the USB port of the laptop or 
make the connection via the laptop clip.

> appears on the display and the Charge LED lights up.
The battery will now be recharged.
It will take four hours to fully recharge the battery.
When the battery is fully recharged the Charge LED will go out.

Note! Charge the camera in time! 
When the battery is empty all photos in the camera memory will be lost.

Camera settings

Selecting the camera frequency
Default frequency setting is 50 Hz (Europe).
1 Press the Mode button until the currently selected frequency is shown on the displ

(for Europe)or (for the U.S.A.).

2 Press the the Shutter button if you wish to change the frequency.

60H50H

US8



3 Press the Mode button to confirm your selection.

lay:

Hq
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Selecting the photo resolution
Default resolution setting is HI.
1 Press the Mode button until the currently selected resolution is shown on the disp

or .

2 Press the the Shutter button if you wish to change the resolution.

3 Press the Mode button to confirm your selection.

Selecting the photo quality
Selects the ratio of image compression. Default quality setting is Hq.
1 Press the Mode button until the currently selected quality is shown on the display:

or .Lq

LoHl



2 Press the the Shutter button if you wish to change the photo quality.

ne
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3 Press the Mode button to confirm your selection.

5. Operating the camera

Turning the camera on and off
1 Slide the lens cover downwards.

2 Press the Mode button to turn on the camera.

> The display lights up blue and you will hear a beep twice.
The display will briefly indicate the current camera mode, and show the number of
photos currently taken .

3 Press and hold the Mode button to turn off the camera.
4 Slide the lens cover upward.

> You will hear a beep and the display shows .The camera is now turned off.
> When no buttons are pressed for 60 seconds, the display goes blank.You will hear o

beep and the camera will turn off automatically.

OFF

0



Taking photos
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1 Make sure the camera is turned on and the lens is uncovered.
2 Look through the viewfinder to frame the object you wish to take a photo of.
3 Press the Shutter button.

> The Timer LED blinks once and you will hear a beep twice when the photo was tak
successfully.

> The display shows the number of photos taken .

Setting the self-timer
1 Make sure the camera is turned on and the lens is uncovered.
2 Press the Mode button until appears on the display.

3 Press the Shutter button to enter Self-timer mode.

> The Timer LED starts blinking red and you will hear a beep every second.
> Ater 10 seconds the camera will automatically take a photo.

St

01



Making a video recording 

um

ENGLISH20
(AVI mode)
1 Make sure the camera is turned on and the lens is uncovered.
2 Press the Mode button until appears on the display.

3 Press the Shutter button within five seconds to start video recording.
Keep the Shutter button pressed for as long as you wish the recording to last (maxim
recording time is 15 minutes).

> When the Shutter button is released, recording will stop and AVI mode is disabled.

Clearing photos and video recordings

Clearing the last stored photo/video recording
1 Make sure the camera is turned on.
2 Press the Mode button until appears on the display.

3 Press the Shutter button to enter Clear Last mode.

CL

Aul
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4 Within five seconds, press Shutter button to confirm that you wish to clear the last s
photo/video recording.
> You will hear a beep once.The last stored photo/video recording has now been cle

from the memory.

Clearing all photos/video recordings
1 Make sure the camera is turned on.
2 Press the Mode button until appears on the display.

3 Press the Shutter button to enter Clear All mode.

> starts blinking.
4 Within five seconds, press the Shutter button to confirm that you wish to clear all

photos/video recordings from the memory.
> You will hear a beep once. All photos/video recordings have now been cleared from

memory.

Transferring photos/video clips to your laptop
1 Be sure the laptop is turned on and that ‘ThumbCam drivers’ and 

‘Philips Photo Manager’ are installed on your laptop.
2 Connect the camera to the laptop, either directly or via the laptop clamp.

See’ Connecting the camera to your laptop’.

> The camera turns on automatically and the display shows .US8

CA

CA



> The following screen will appear.You can now transfer your files to your hard disc by
following the instructions on the screen.

’ and
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3 If you wish to start transferring press ‘YES’.
>The following screen will appear.

4 Select the photos you wish to transfer and press ‘OK’.
> If the transfer is complete the following screen will appear.

Notes! If the ‘Philips ThumbCam’ screen does not appear, you can start ‘Philips Photo Manager
click on the 'Get Photo' icon. Select your camera (ThumbCam) to start the transfer.

Transferring photos/video clips by ‘Drag and drop’
1 Be sure the laptop is turned on and that ‘ThumbCam drivers’ and ‘Philips Photo Ma

are installed on your laptop.
2 Connect the camera to the laptop, either directly or via the laptop clamp.

See’ Connecting the camera to your laptop’.



> The camera turns on automatically and the display shows .
3 Open ‘Windows® Explorer’ or click on ‘My computer’.

ur

the
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4 Select ‘Removable Disk’.
5 Select the files you wish to transfer and drag them to any preferred location on yo

hard disk.

Using the camera as a removable memory drive - USB mode
1 Make sure the laptop is turned on and that ‘ThumbCam drivers’ and 

‘Philips Photo Manager’ are installed on your laptop.
2 Connect the camera to the laptop, either directly or via the laptop clamp.

See’ Connecting the camera to your laptop’.

> The display shows .The camera is now in USB mode and will be recognised by 
laptop as a removable memory drive.

> Camera memory content can now be transferred to the laptop hard disk.
See ‘Transferring photos/video clips to your laptop’.

Using the camera as a PC camera - PC mode
1 Make sure the camera is turned on and the lens is uncovered.
2 Press the Mode button until appears on the display.

3 Now connect the camera to the laptop (see ‘Connecting the camera to your lapto
> The camera is now in PC mode and can be used as a PC-camera (webcam).

Also see chapters ‘Transferring/viewing photos and video clips’, ‘NetMeeting’ and
‘Microsoft® MSN Messenger’ and ‘Yahoo!®Messenger’.

PC

US8



Switching from PC mode to USB mode while connected to the
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laptop
• Press the Shutter button.

Switching from USB mode to PC mode while connected to th
laptop
1 Double click on the ‘Unplug or eject hardware’ icon in the right bottom corner of 

screen.

2 Select ‘USB man storage device’ and click on ‘STOP’.

3 Select ‘Philips ThumbCam’ and click on ‘STOP’.
> The camera will now turn off automatically.

4 Press the Mode button until appears on the display.

> The camera is now in PC mode and can be used as a PC-camera (webcam).

PC



6. Using the applications
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Philips VLounge
Note! Make sure your laptop runs Microsoft® Windows® 98SE, ME, 2000 or XP and that you

run the Philips ThumbCam Installation CD-ROM in your laptop.

All applications can be accessed via the Philips V(ideo)-Lounge application.VLounge is the 
application for easy access to your Philips ThumbCam and all image and video applications
installed during setup.You can start VLounge through the Windows QuickLaunch menu in 
taskbar, via the program group ‘Philips FunCam’, or by clicking the VLounge icon on t
desktop.
VLounge gives you access to the following applications (if installed):
1 Image - Philips Photo Manager
2  Video - Philips VRecord
3  Video Chat - Windows® NetMeeting

- Links to Microsoft® MSN Messenger and Yahoo!® Messenger downloads.
• Move the cursor over the buttons in the screen below to find out more about the

specific functions of VLounge.
• Click the buttons to start the applications.

> If a button is greyed out, this means that the application has not been installed.To in
the application, see ‘Installing the camera software’.

Optional buttons
4 ThumbCam manual
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Microsoft® Netmeeting
Microsoft® NetMeeting enables you to communicate with others over the Internet or you
intranet.

To initiate a video chat:
1 Start NetMeeting by clicking the NetMeeting button in the VLounge selection scree

2 Click on ‘Help’ -> ‘About NetMeeting’ and find out your local IP address.You can as
meeting partner to find out his/her IP address in the same way.

3 Click the telephone icon.

4 In the ‘Place A Call’ dialogue box, fill in your partner's IP address in ‘To: ‘ 
5 Click on ‘Call’ and wait for response.

Note! If you or your partner are/is behind a firewall or is using a proxy server 
(common for office users), please refer to NetMeeting Help about detail solutions.



To respond to an incoming call:
1 You can choose ‘Automatically Accept Calls’ or you can accept manually.
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2 When the ‘Incoming Call’ dialogue box appears, click on ‘Accept’.

Notes!
– Only two computers in a NetMeeting conference can use audio for communication. All oth

participants must communicate through other options, like Chat or the shared Whiteboard
– You can also initiate a video conference with more than one partner.

Please read Help in Microsoft®NetMeeting.

Microsoft® MSN Messenger and Yahoo!® Messenger
Philips VLounge contains web links allowing you to download Microsoft® MSN Messenger 
Yahoo!® Messenger.These applications enable immediate contact with other persons onlin
Your messages, as well as the response from the receiving person, will be delivered instant
Just as if you where having a normal person-to-person conversation.
With Microsoft® MSN Messenger and Yahoo!® Messenger you can study online with classm
play games, work with colleagues, exchange ideas, ‘hand over’ photos and files, meet new p
surf the web together and much, much more.
• Just click on the desired link and follow the on-screen instructions to download an

install the applications.

Image

Philips Photo Manager
Philips Photo Manager enables you to transfer, preview, edit, e-mail, print and organise you
photos and video recordings.

1 Click on the ‘Philips Photo Manager’ button in the VLounge selection screen.

2 If you are using ‘Philips Photo Manager’ for the first time, click the ‘Search’ icon in t
tool bar if the search for photos and video recordings does not start automatically.
> All photos and video clips, located anywhere on your system, will now be searched
> After the search, all folders containing photos and clips will be shown on your desk



• Double-click on a folder to show its content.
• Using the tools in the toolbar you can now edit your photos, create slide shows, add audio,

Help’
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create new albums and much more.
• If you need more information on the possibilities of ‘Philips Photo Manager’, select ‘

in the toolbar and then select ‘Contents...’.
> In the chapters ‘Albums/Tree structure’, ‘Menu commands’, ‘Tools’, ‘Editing tools’ and ‘Adv

features’ you will find all the information you need to create customised multimedia colle
from files located anywhere on your system.

Video

Philips VRecord
Philips VRecord enables you to record video clips onto your hard disk.

1 Click the ‘Philips VRecord’ button in the VLounge selection screen.

> The ‘Philips VRecord’ screen appears.

2 Select a file name in the File menu using 'Set Capture File'.
3 Click 'Devices' to set the video and audio source you want to use.

4 Enable 'Preview' in the Options menu to see the live Philips USB Web Camera prev
then adjust your audio and video settings if necessary. For instance the ‘Frame Rate
setting in the Options - Video Format menu which determines the frame rate the P
USB Web Camera hardware should deliver to VRecord.



5 Use the Capture menu to start or stop capturing a video. Enable 'Capture Audio' if you
want to record sound together with the camera photos. (See below for other capture

file
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options.)
6 You can replay the recording by opening the AVI file you selected for your capture 

name in the File - Set Capture File menu. Double click this AVI file in Windows Exp
and Windows Media Player will show you the recording.

Other capture options
The 'Master Stream' option determines the preferred synchronisation between the video 
and the recorded sounds.
• Select 'Audio' if you want to make sure the video rate adapts to the sound recordi

rate.
• Select 'Video' if you want to make sure the sound recording rate adapts to the vide

recording rate. If 'None' is enabled,VRecord will adapt both streams to each other
whenever necessary.

If 'Use Frame Rate' is enabled in Capture - Set Frame Rate it determines the software fram
rate in which VRecord captures the movie independently from the hardware frame rate
delivered by the Philips USB Web Camera according to the Frame Rate setting in the Opt
VideoFormat menu



7. Problem solving
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If a fault occurs, first check the points listed below. If you are unable t
remedy a problem by following these hints, contact the helpline
(see ‘Helpline’) or consult your dealer.
Never try to open the camera yourself as this will void the guarantee

First, check all cables to ensure that they are connected correctly.

Problem Possible cause / Solution

No photo is taken Battery exhausted
while the Shutter • Recharge battery. See ‘Recharging the battery.
button is pressed Memory full
all the way down • Transfer photos/video recordings to your laptop or clear photos i

order to create memory space. See ‘Transferring/viewing photos a
video recordings’ and/or ‘Clearing photos and video recordings’.

Camera is still connected to the laptop’s USB port
• Disconnect the camera from the laptop’s USB port or take the ca

out of laptop clip.
Poor light conditions
• Try to improve the light conditions.
Camera turned off automatically (no button pressed for 60 second
• Turn the camera back on. See ‘Turning the camera on and off ’.

No reaction Battery exhausted
to controls • Recharge battery. See ‘Recharging the battery.

File transfer not USB connection not properly made
possible • Properly connect the USB cable to both camera and laptop and m

sure the camera is placed in the laptop clamb or properly connec
camera directley to the USB port of the laptop.

USB driver not installed
• Install USB driver and ‘Philips Photo Manager’ on your laptop.

Not all images The RAM memory installed in your computer may not have 
can be transferred sufficient storage space.
to the laptop • Close all software programs and proceed to transfer your images

problem persists, transfer images in batches and store each batch 
your hard drive before proceeding to the next batch. Make sure a
images you want are stored before you clear the camera memory

Camera • Check if the camera power is turned on. If not, turn it on and the
connected to laptop connect the camera to the laptop again, either directly or by placi
but the Philips the laptop clip.
ThumbCam driver 
says: Device not ready’.
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ENGLISH 31
Image resolution .......................................................................................1.3 Mega pixels (1280 x 1024)

Sensor...........................................................................................................................................1/2” 1.3 MP CMOS

PC camera resolution (connected to PC) .......................VGA (640 x 480) up to 15 fps or
CIF (320 X 240) up to 30 fps

Video resolution (disconnected from PC) ............................CIF (320 X 240) up to 15 fps

Built-in battery .............................................Li-polymer battery 220 mAh. Rechargeable via USB

PC interface .....................................................................................................................................................USB 1.1

Internal memory capacity......................................................................................................128 MB Flash

Case material .......................................................................................................................................................Metal

Power up time ...........................................................................................................................................2 seconds

Auto Power off .......................................................................................................................................60 seconds

Still image format..............................................................................................................................................JPEG

Video file format....................................................................................................................................................AVI
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Disclaimer
Philips makes no warranty of any kind with regard to this material, including, but not limited
the implied warranties of merchantability and fitness for a particular purpose. Philips assum
responsibility for any error that may appear in this document. Philips makes no commitmen
update nor to keep current the information contained in this document.

FCC compliance 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
conditions:
1 this device may not cause harmful interference, and 
2 this device must accept any interference received, including interference that may caus

undesired operation.

Note!
This equipment has been tested and found to comply with the limits for a Class B digital device
pursuant to Part 15 of the FCC Rules.These limits are designed to provide reasonable protectio
against harmful interference in a residential installation.This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions
cause harmful interference to radio communications. However, there is no guarantee that interfe
will not occur in a particular installation. If this equipment does cause harmful interference to ra
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different from that to which the rece

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Any unauthorized modification to this equipment could result in the revocation of the
authorization to operate the equipment.
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Philips is paying a lot of attention to producing environmentally-friendly in gre
areas.Your new camera contains materials which can be recycled and reused.
end of its life specialised companies can dismantle the discarded camera to
concentrate the reusable materials and to minimise the amount of materials t
disposed of.
Please ensure you dispose of your old camera according to local regulations.

Note! This product may contain lead and mercury. Disposal of these materials may be regulat
to environmental considerations. For disposal or recycling information, please contact you
authorities or the ElectronicIndustries Alliance (U.S. specific): www.eiae.org.

System requirements 
• Microsoft® Windows® 98SE/2000/ME or XP;
• Pentium® II or AMS K6-ll or above;
• 32MB RAM and 100 MB free hard disk space;
• One free USB port and CD-ROM-/DVD drive.

Disclaimer of warranty
The software on the CD-ROM supplied is sold ‘as is’ and without warranties whether exp
or implied. Because of the various software and hardware environments into which this pr
may be put, no warranty of fitness for a particular purpose is offered.

Limitations of damages
The vendor will not be liable for any indirect, special, incidental or consequential damages
(including damages for loss of business, loss of profits, or the like), whether based on breac
contract, tort (including negligence), product liability or otherwise, even if the vendor or its
representatives have been advised of the possibility of such damages and even if a remedy
forth herein is found to have failed its essential purpose.



10. Helpline

stance!

ENGLISH34
Need Help?
If you have any questions about the Philips ThumbCam, please contact our helpline for assi
You can find the number in the list below.

Before you call, please read this manual carefully.
You will be able to solve most of your problems.

The model number of the camera is DMVC1300K.

Date of purchase: _____ /_____ /______
day /month /year

België/ Belgien/ Belgique Nederland 

02-275-0701 053-482-9800

Danmark Norge 
35-25-8761 22-70-82-50

Deutschland Österreich
0696-698-4712 01-546-575-603

España Portugal
09-17-45-62-46 0800-831-363

France Schweiz/ Suisse/ Svizzera
03-8717-0033 02-23-10-21-16

������� Suomi 
00800 3122 1223 09-2290-1908

Ireland Sverige
01-601-1161 08-632-0016

Italia UK (United Kingdom)
02-48-27-11-53 0207-949-0069

Luxemburg/ Luxembourg
408-433-5501



11.Warranty
Guarantee certificate
Garantiebewijs

Certificat de garantie
Certificado de garantia

Garantieschein
Certificato di garanzia
Certificado de garantia
Garantibevis

���	�
�
Garantibevis

Garanticertifikat
Takuutodistus

year warranty
année garantie
Jahr Garantie
jaar garantie
año garantia
anno garanzia

������ ���	
�


år garanti
år garanti
år garanti
vuosi takuu
año garantia22

0682
www.philips.com
Data subject to change without notice

Dealer’s name, address and signature
Nom, adresse et signature du revendeur
Name, Anschrift und Unterschrift des Händlers
Naam, adres en handtekening v.d. handelaar
Nombre, direccion y firma del distribudor
Nome, indirizzo e firma del fornitore
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Återförsäljarens namn, adress och signatur
Forhandlerens navn, adresse og unterskrift
Forhandlerens navn, adresse og unterskrift
Jälleenmyyjän nimi, osoite ja allekirjoitus
Nome, morada e assinature da loja

Type: DMVC 1300K

Serial no: ___________________________________________________________________

Date of purchase - Date de la vente - Verkaufsdatum - Aankoopdatum - Fecha de compra - Date d’acquisito - 
Data da adquirição - G
���

��� ������ - Inköpsdatum - Anskaffelsesdato - Kjøpedato - Oatopäivä - 

6 month guarantee on rechargeable batteries
6 mois de garantie sur les piles rechargeables
6 meses de garantía para las pilas recargables
6 Monate Garantie auf wiederaufladbare Batterien
6 maanden garantie op oplaadbare batterijen
Garanzia di 6 mesi sulle batterie ricaricabili

Pilhas recarregáveis com 6 meses de garantia
E��	
�
 6 

��� �� ������������
���� 
��������

6 månaders garanti på laddningsbara batterier
6 måneders garanti på genopladelige batterier
6 måneders garanti på de oppladbare batteriene
Ladattavilla akuilla on 6 kuukauden takuu


